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ABSTRACT 

The automation is also became a part of our lives. The people operate with automation

systems in everywhere. Technology is entered to every platform of our life human

needed to combine both softwaresand-hardware ..-Without software the machines are

nothing. They need software to operate.

Human who tried to satisfy wonder.Such humanity came to nowadays as

develop.Todays everyone says technology perfect developed.By means of technology

aJJ process gained velocity.This development acts to spend time to the people.

Doctors, yes doctors which are respectable people. Because they make an-effort to heal

for people health. But what a shame people do not share the same idea. Which can kiJJ

other people who can not adopt same opinion with other or who are not like with other.

We owe many things for doctors'They strive day and night to give health people.

.Thats why hospital project choosed to help for doctors, to decrease paper documentation

time of a doctor. In this software doctor or user can keep patient informations, illnesses

background information of the patient, operations background information of the

patient,.With this software aJJ informations will check easly, thus people will keep

health.

••
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INTRODUCTION 

Do you imagine a life without computers. Especially a life without electricity. This

imagine makes choke the people. Electricity also computers are part of human

nowadays. Yes they are not real part like arms or legs but they are part like clothes; well

they are indispensable. People tie to these parts day by day because which gives

easiness and trustworthiness to them.

People adapt everything to computers because results of tie. Here I want to adapt health

services to safe and rapid computer systems in this project.

In this project keep patients informations, illnesses informations, operation informations

and sort them by patient id. These informations are investigated rapidly by program.

Thats why the doctor obtain time to intersted in with patients.

The program provide a wide search criteria to users. Which property acts for all

informations to be usable without null informations.

Now doctors will save null time that would be documentation and they interested in

with patients as much more ...

.•. 

• 
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CHAPTER! 

DELPHI 

1.1 INTRODUCTION TO DELPHI 

Delphi is a communication structure aimed at producing detailed critical examination

and discussion, not at forcing a quick compromise. Certainly quantification is a

property, but only to serve the goal of quickly identifying agreement and disagreement

in order to focus attention. It is often very common, even today, for people to come to a

view of the Delphi method that reflects a particular application with which they are

familiar. In 1975 Linstone and Turoff proposed a view of the Delphi method that they

felt best summarized both the technique and its objective:

"Delphi may be characterized as a method for structuring a group communication

process, so that the process is effective in allowing a group of individuals, as a whole, to

deal with complex problems." The essence of Delphi is structuring of the group

communication process. Given that there had been much earlier work on how to

facilitate and structure face-to-face meetings, the other important distinction was that

Delphi was commonly applied utilizing a paper and pencil communication process

among groups in which the members were dispersed in space and time. Also, Delphis

were commonly applied to groups of a size (30 to 100 individuals) that could not

function well in a face-to-face environment, even if they could find a time when they all

could get together.

The name "Delphi" was never a term with which either Olaf Helmer or Norman Dalkey

(the founders of the method) were particular happy. Since many of the-early Delphi

studies focused on utilizing the technique to make forecasts of future occurrences, the

name was first applied by some others at Rand as a joke. However, the name stuck. The

resulting image of a priestess, sitting on a stool over a crack in the earth, inhaling sulfur

fumes, and making vague and jumbled statements that could be interpreted in many

different ways, did not exactly inspire confidence in the method.

The straightforward nature of utilizing an iterative survey to gather information

"sounds" so easy to do that many people have done "one" Delphi, but never a second.

1 
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e the name gives no obvious insight into the method and since the number of

.uccessful Delphi studies probably exceeds the successful ones, there has been a Jong

istory of diverse definitions and opinions about the method. Some of these

misconceptions are expressed in statements such as the following that one finds in the

iterature:

It is a method for predicting future events.

It is a method for generating a quick consensus by a group.

It is the use of a survey to collect information.

It is the use of anonymity on the part of the participants.

It is the use of voting to reduce the need for long discussions.

It is a method for quantifying human judgement in a group setting.

Some of these statements are sometimes true; a few (e.g. consensus) are actually

contrary to the purpose of a Delphi.

Additional opportunity has been added by the introduction of Computer Mediated

Communication Systems (Hiltz and Turoff, 1978; Rice and Associates, 1984; Turoff,

1989; Turoff, 1991). These are computer systems that support group communications in

either a synchronous (Group Decision Support Systems, Desanctis et. al., 1987) or an

asynchronous manner (Computer Conferencing). Techniques that were developed and

refined in the evolution of the Delphi Method (e.g. anonymity, voting) have been

incorporated as basic facilities or tools in many of these computer based systems. As a

result, any of these systems can be used to carry out some form of a Delphi process or

Nominal Group Technique (Delbecq, et. al., 1975).

The result, however, is not merely confusion due to different names to describe the

same things; but a basic lack of knowledge by many people working in these areas as to

what was learned in the studies of the Delphi Method about how to properly employ

these techniques and their impact on the communication process. There seems to be a

great deal of "rediscovery" and repeating of earlier misconceptions and difficulties.
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mpiles the code you write and produces really tight, natively executable code for the

get platform. In fact the most recent versions of Delphi optimise the compiled code

d the resulting executables are as efficient as those compiled with any other compiler

rrently on the market.The term "visual" describes Delphi very well. All of the user

terface development is conducted in a What You See Is What You Get environment

"\VYSIWYG), which means you can create polished, user friendly interfaces in a very

hort time, or prototype whole applications in a few hours.

1.3 DELPHI SYNTAX AND DELPHI STRUCTURE 

Delphi is a Rapid Application Development (RAD) environment. It allows you to drag

and drop components on to a blank canvas to create a program. Delphi will also allow

you to use write console based DOS like programs.

Delphi is based around the Pascal language but is more developed object orientated

derivative. Unlike Visual Basic, Delphi uses punctuation in its basic syntax to make the

program easily readable and to help the compiler sort the code. Although Delphi code is

not case sensitive there is a generally accepted way of writing Delphi code. The main

reason for this is so that any programmer can read your code and easily understand what

you are doing, because they write their code like you write yours.

For the purposes of this series I will be using Delphi 7. There are more recent versions

available (2005 and 2006) hıwever Delphi 7 should be available inexpensively

compared to the new versions which will set you back a lot of money.

1.3.1 A Delphi Program 

Notice the first line refers to the keyword program. You can rename this to Hello World.

You can also remove the commented portion enclosed in curly brackets.

The uses keyword allows you to list all units that you want to use in the program. At the

moment just leave it as it is, SysUtils is all we need.
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thing is first, fire up your copy of Delphi and open the Project > Options menu. To

pile a console application you need to change a setting on the Linker tab called

"Generate console application', check the box and click OK. Now select File > Close

if anything is already loaded. Then select File > New > Other > Console

Application.

'our unit should now look like this:

Delphi Code:

program HelloWorld;

{$APPTYPE CONSOLE) 

uses

SysUtils;

begin

end.

Now what we have just done is written a program, it currently doesn't do a thing

however. Hit the run button and see the result. Now wasn't that completely worthless.

Luckily this isn't the end of the article so we'll actually have a worthwhile program at

the end of it. All we need to do is insert some code in the main procedure we have just

made.

Every good programmer's first program was 'Hello World' and you'll be no exception.

All we need to do is use the WriteLn procedure to write 'Hello World!' to the console,

simple.Notice the semicolon at the end of the line, at the end of any statement you need

to add a semicolon. Run the program and see the results.
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.phi Code:

gram HelloWorld; WriteLn('Hello World!' + #13#10 + 

#13#1 O+
APPTYPE CONSOLE} 

'Press RETURN to end ... ');
es

ReadLn;
SysUtils;

end.
egın

1.3.2 Design Of Delphi 

Coding style, the way you format your code and the way in which you present it on the

page.At the end of the day who cares about my style, I can read it, and Delphi strips all

the spaces out of it and doesn't care ifl indent. Why waste my time?

Neatly present code which conforms to the accepted standards not only makes your

code much easier for you to read and debug but also but any one else who might read

your code to help you, or learn from you can do so with ease. After all which code is

easier to follow, example 1 or 2?

Example 1:

procedure xyz(); a:=power(z,y);

var x,y,z,a:integer; showmessage( inttostr( a));

begin end;

x:=l;y:=2; end;

for z:=x to y do begin
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E~ample 2:

ocedure XYZ(); begin

·ar X,Y,Z,A: Integer; A := Power(Z, Y);

gm ShowMessage(lntToStr(A));

X := 1; end; II for end 

y :=2; end; II procedure end 

for Z := X to Y do

Much of the ground-breaking work on design patterns was presented in the book Design

Patterns: Elements of Reusable Object-Oriented Software by Gamma, Helm, Johnson

and Vlissides. You might also have heard of the authors referred to as "the Gang of

Four". If you haven't read this book before and you're designing objects, it's an excellent

primer to help structure your design. To get the most out of these examples, I

recommend reading the book as well.

Design patterns are frequently recurring structures and relationships in object-oriented

design. Getting to know them can help you design better, more reusable code and also

help you learn to design more complex systems.

Another good source of pattern-concepts is the book Object Models: Strategies, Patterns

and Applications by Peter Coad. Coad's examples are more business oriented and he

emphasises learning strategies to identify patterns.in your own work."

1.4 DELPHI CLASS DEFINITIONS 

1.4.1 Unit Structure 

Delphi units (.PAS files) allow declaration of interface and implementation sections.

The interface defines the part that is visible to other units using that unit. The keyword
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uses can be added to a unit's interface or implementation section to list the other units

at your unit uses. This indicates to the compiler that your unit refers to parts of the

ed unit's interface. Parts of a unit declared in the implementation section are all

rivate to that unit, i.e. never visible to any other unit. Types, functions and procedures

declared in the interface of a unit must have a corresponding implementation, or be

declared as external (e.g. a call to a function in a DLL).

1.4.2 Class Interfaces 

Classes are defined as types in Delphi and may contain fields of standard data types or

other objects, methods declared as functions or procedures, and properties. The type

eclaration of a class defines its interface and the scope of access to fields, methods and

roperties of the class. Class interfaces are usually defined in the interface of a unit to

make them accessible to other modules usirıg that unit. However they don't need to be.

ometimes a type declaration of a class may be used only within the implementation

part of a unit.

1.4.3 Properties 

Properties are a specialised interface to a field of a defined type, allowing access control

through read and write methods. Properties are not virtual, you can replace a property

with another property of the same name, but the parent, class doesn't know about the

new property. It is however possible to make the access methods of a property virtual.

•

1.4.4 Inheritance 

Delphi's inheritance model is based on a single hierarchy. Every class inherits from

TObject and can have only one parent.

A descendant class inherits all of the interface and functionality of its parent class,

subject to the scope described below.
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iple inheritance from more than one parent is not allowed directly. It can be

lernented by using a container class to create instances one or more other classes

electively expose parts of the contained classes.

·ate, Protected, Public and Published ScopeScope refers to the visibility of methods

data defined in the interface of a class, i.e. what parts of the class are accessible to

rest of the application or to descendant classes.

default scope is public, for instance the component instances you add to a form at

sign time. Public says "come and get me"; it makes the data or method visible to

erything at runtime.

lished parts of a class are a specialized form of Public scope. They indicate special

haviour for classes derived from TPersistent. A persistent class can save and restore

~ published properties to persistent storage using Delphi's standard streaming methods.

blished properties also interact with Delphi Object Inspector in the IDE. A class must

escend from TPersistent in order to use Published. There's also not much point in

ublishing methods, since you can't store them, although Delphi's compiler doesn't stop

you. Published also lets another application access details of the class through Delphi's

ntime type information. This would be rarely used, except in Delphi's design time

teraction with its VCL.

Encapsulation or information hiding is essential to object orientation, so Protected and

Private scope let you narrow tl\r access to parts of a class.Protected parts are visible

only to descendant classes, or to other classes defined in the same unit.

• Private parts are visible only to the defining class, or to other classes defined in the

ame unit.It's important to note that once something is given public or published scope,

it cannot be hidden in descendant classes. Static, Virtual and Dynamic Methods;

Override and Inherited. Methods declared as virtual or dynamic let you change their

behaviour using override in a descendant class. You're unlikely to see a virtual method

in the private part of a class, since it could only be overridden in the same unit, although

Delphi's compiler doesn't stop you from doing this.
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erride indicates that your new method replaces the method of the same name from

arent class. The override must be declared with the same name and parameters as

original method.When a method is overridden, a call to the parent class's method

lly executes the override method in the real class of the object.Static methods on

other hand have no virtual or override declaration. You can replace a method of a

~~ in a descendant class by redeclaring another method, however this is not object

ented, If you reference your descendant class as the parent type and try to call the

aced method, the static method of the parent class is executed. So in most cases, it's

ad idea to replace a static method.

al and dynamic methods can be used interchangeably. They differ only in their

trnent by the compiler and runtime library. Delphi's help explains that dynamic

ethods have their implementation resolved at compile time and run slightly faster,

ereas virtual methods are resolved at runtime, resulting in slightly slower access but

smaller compiled program. Virtual is usually the preferred declaration. Delphi's help

suggests using dynamic when you have a base class with many descendants that may

t override the method.The inherited directive lets you refer back to a property or

method as it was declared in the parent class. This is most often used in the

implementation of an override method, to call the inherited method of the parent class

and then supplement its behaviour.

1.4.5 Events 

Events are also an important characteristic· of Delphi, since they let you delegate

extensible behaviour to instances of a class. Events are properties that refer to a method

of another object. Events are not inherited in Delphi 1; Delphi 2 extends this behaviour

to let you use inherited in an event. . Inherited in an event handler just uses the keyword

inherited, there is no need to supply the name of the method to call.

Events are particularly important to component developers, since they provide a hook

for the user of the component to modify its behaviour in a way that may not be foreseen

at the time the component is written.
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.6 Messages

phi's handling of Windows messages is a special case of virtual methods. Message

dlers are implemented in classes that descend from TControl. I.e classes that have a

dle and can receive messages. Message handlers are always virtual and can be

lared in the private part of a class interface, yet still allow the inherited method to be

led. Inherited in a message handler just uses the keyword inherited, there is no need

supply the name of the method to call.

1.4.7 Constructors and Destructors

e constructor and destructor are two special types of methods. The constructor

itializes a class instance (allocates memory initialized to O) and returns a reference

inter) to the object. The destructor deallocates memory used by the object (but not

e memory of other objects created by the object).

Classes descended from TObject have a static constructor, Create, and a virtual

estructor Destroy.TComponent introduces a new public property, the Owner of the

omponent and this must be initialized in the constructor. TComponent's constructor is

declared virtual, i.e. it can be overridden in descendant classes.It is essential when you

override a virtual constructor or destructor in a TComponent descendant to include a

all to the inherited method.

1.5 VISUAL COMPONENT LIBRARY • 

Applications Developers create complete applications by interacting with the Delphi

isual environment (as mentioned earlier, this is a concept nonexistent in many other

frameworks). These people use the VCL to create their user-interface and the other

elements of their application: database connectivity, data validation, business rules, etc ..

Applications Developers should know which properties, events, and methods each

component makes available. Additionally, by understanding the VCL architecture,
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